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Guidelines for using your camcorder 

 
Benefits of Video Analysis 

Humans have quite slow vision. The human eye can only separate a maximum of 
ten / twelve images per second… There are even some suggestions amongst 
scientists that events lasting less than 0.25 seconds cannot usually be seen clearly. 
Although coaches are irreplaceable in analysing athlete's techniques, often the 
coach's eye cannot extract all the necessary details in a live sporting situation.   

Video cameras create the illusion of motion by ‘tricking’ the human eye. Video 
cameras play 25 flashing still pictures each second. As an eye cannot separate 
those pictures, we get the feeling of continuous movement. The use of a video 
camera is a very effective tool to help you improve sporting technique. Quintic 
video analysis software enables video capture at 25, 50 and 100fps. At 100fps each 
still image is 10ms, capable of capturing even the fastest of human movement. In 
addition to just one video camera, Quintic has the capability of capturing two live 
video images, simultaneously. The benefits of video have just doubled!  

More and more athletes, coaches, scientists are using video feedback as a coaching 
aid. Video can very quickly help athletes to understand the basic fundamentals of a 
specific movement. Providing athletes with immediate performance feedback via 
Quintic video software is a very powerful analysis tool… the images are used to 
assist coaches in their task, as the athlete's performance can be repeated 
afterwards and slowed down during critical phases. 

By comparing performances of previous movements, or even other athletes, the 
Quintic software enables you to compare video images via the computer screen. 
Differences between the techniques can be identified (competition vs. training) 
and this information made available immediately to the athlete. The coach and the 
athlete can discuss what they see and plan a strategy for improvement, then repeat 
the process.  How the feedback is presented to the athlete when using Quintic is 
highly dependable upon the skill of the coach or analyst. 
 

They say 'Pictures paint a thousand words' and to see the critical 
angles and positions of your run up and delivery stride helps me make 
instant changes to my action. Quintic is another dimension for any 
training programme..." 
                                           Matthew Hoggard 
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Over the recent years the role that information technology has played in sport 
coaching has dramatically increased in a wide range of areas, including assisting in 
the delivery of performance feedback. Practice should be a rewarding experience; 
a video camera helps you make the most out of your time. When you watch 
yourself perform via the computer screen, the image is there before your eyes, 
instead of being just in your mind.  

 

"Being able to synchronise different throws, current and best, proved 
invaluable in preparation for the games in Sydney 2000 & Athens 2004. 

I can compare the timing of current training throws with my best 90m 
efforts from previous years. By synchronising current and best throws at 
release we could rewind in slow motion and analyse the differences." 

 Steve Backley 
 
By studying your technique in depth, (frame by frame), you can start to building a 
picture of what you're trying to achieve. Seeing an improvement can boost your 
confidence. Normally it's difficult to correct a fault, even if you know what you 
should be doing. This is because you don't see yourself in action. The slightest 
alteration to the technique will always feel uncomfortable to begin with. Negative 
thoughts and doubts can soon eat away at your performance. It is then you start 
drifting into old habits, simply because that's what comes naturally. You have aged 
bad habits and before long you are back to square one. When the video or 
computer images are there in front of you, it's much easier to set yourself back on 
the right lines. You can learn a great deal from studying your own technique on 
video. The benefits of video apply to all levels of performance - from the beginner 
to the Elite athlete, all you need is a video camera and Quintic software... 
Remember the camera never lies...  

" With the assistance of Quintic analysis software I’ve transformed my 
putting stroke. Visually it looks quite different but the changes have been 
quite easy to make. What you think you are doing, compared to what you 
are actually doing can be two totally different things."    

        David Howell 
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More Detailed Video Instructions: 

Whilst any camera is better than no camera and any video image is better than 
none, some simple tips will enhance the value of your images... There are four 
basic operations, which can significantly influence the use of cameras and the 
quality of images. These are zoom, focus, shutter speed and iris. 

During set-up of your camera, it is important to be at right angles, or 90 degrees 
to the action. The zoom function in the camera changes the picture size and 
allows you to stand much further back from the action. It is important that the 
athlete is as large as possible in your camera view and the zoom allows you to have 
all the details of the performance on the camera as you can restrict the view to be 
just around the athlete. The camera should be set up so that the entire body is 
contained within each frame. The correct distance between the camera and 
subject should be recorded, to allow comparisons in the future (Typically 8-
10metres). Set the camera to automatic focus.  Data collected using Quintic 
Biomechanics must have a repeatable and consistent set-up protocol. This will 
ensure the numeric & graphical representation of variables such as speed, 
distance, acceleration are accurate. Quintic also accounts for any Parallax error 
values during the calibration of any particular video. 
 
However, if using a panning or moving camera often a manual focus will ensure 
correct images are recorded. Auto focus constantly checks and focuses based on 
what is at the centre of the picture. This, though, is not always practical when 
videotaping athletes. By learning to use manual focus, you can avoid this problem. 
Manual focus is set for a certain distance (you do not need to know the distance) 
and anything that distance away from the camera is in focus. This is another 
reason for you to stay far away from the athlete (and use the zoom function). 

A good hint for manual focusing from a long distance is that you zoom in as close 
as possible, focus your camera using something like the text on an athlete's 
clothing and then zoom out to a desired level so that the whole athlete can be seen 
in the picture. The image stays focused, as zoom and focus are independent of 
each other. 

The iris is the function in your camera, which allows the light come to the camera 
through the lens. Many cameras have this only as an auto function and so you may 
not be able to change it. In any case, auto iris is not such a bad thing as the lighting 
conditions could change during the session, as happens when clouds go in the 
front of the sun. If you have a camera with a manual iris option, then you can test 
out its influence on the picture quality. Obviously, more light (smaller iris 
number) makes your picture brighter (but can also make it too bright), while 
closing the iris makes the picture darker. 
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Shutter speed options are essential for good quality video taping of athletics 
performance, particularly when the speeds are fast... In a normal situation, the 
picture is taken over 0.04 seconds (25 pictures in a second). During even that 
short time, however, an athlete can move a great deal and thus you see a blurred 
image in your slow motion tape (like TV slow motion repetitions of a tennis ball 
in a close line call - often you do not really see the ball at all, just a trace of 
blurred ball images). Shutter speed allows you to reduce the time over which the 
individual picture is taken. The majority of camcorders today have automatic 
settings for various filming projects (refer to manufacture's guidelines). However, 
the sports setting - typically a picture of a golfer or runner will provide you with 
the highest shutter speed setting. 

Note: That does not allow you to take any more pictures: there are still only 25 / 
50 or 100 fps frames per second (as this is pre-determined by the camera and 
computer software), but each picture is taken in a shorter period of time. A 
shutter speed of 1/500s means that each picture is taken over a 0.002s. The down 
side of increasing the shutter speed is that you need much more light. This is not 
usually a problem outdoors, and it is recommended to use at least 1/1000s 
shutter speed for athletics movement if possible, shutter speeds of 1/10,000 can 
be used for particular sharp and clear images.. However, sometimes when filming 
indoors you need to compromise and use a lower shutter speed. Additional 
lighting may well be required. 

Quintic would recommend you to make a verbal report to the camera after each 
shot, throw, jump… for example; commenting on the flight, distance, result... 
Without this information, the subsequent viewing of the tape will not give the 
best possible information.  
Finally, remember that the videotapes always rewind slightly at the end of the 
recording, so be careful not to cut away the end of the performance when you 
stop the recording. Videotape a few seconds prior to and after the actual 
performance. This also makes it much easier to look at the tapes, as there are 
clear, distinct sequences on the tape.

 
 

 

Appendix A 



Notes 

 
 
 
 
 
 
 
 
 
 
 
 

 



 
 
 
 

Appendix B 
 

 

Trouble Shooting 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



Trouble Shooting
 
Missing or dropped frames 
When capturing video, a hidden file called sample.avi is generated. When you 
trim in and trim out it is this file that is edited. When you next capture, this 
sample.avi file gets overwritten with the new footage. 
 
When first using the camera capture feature within Quintic you may find that 
frames are dropped during the capture process. To overcome this, it worthwhile 
defragmenting your hard drive. 
 
When you use the same file over and over again, writing, rewriting, saving, and 
deleting parts of it on the same disk, the file becomes fragmented. That means 
that although you can't tell, your operating system is storing all the data from that 
file as separate packages of information, distributed on different parts of the disk. 
Although fragmentation does not lose the information contained in the file, it does 
eventually slow down access to the file itself, because Windows must search the 
whole disk to create the sum of the file's parts. Defragmentation collects all those 
parts into one stream of data again, speeding up your system. 
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To defrag your hard drive for better capture performance do the following: 
1) Capture 30 s worth of video using the camera capture software within Quintic 
(do not worry if frames are dropped during this process). 
 
2) Close down Quintic and all other applications. 
 
3) Click Start, point to All Programs, point to Accessories, point to System 
Tools, and then click Disk Defragmenter. 
 
4) Select C: drive and click on defragment. Note: depending on the size of drive 
and number of files this process can take a long time (allow for at least an hour). 
 
5) Recapture. 
 
After defragmenting, if you still experience dropped or missing frames then it is 
likely that your computer is not powerful enough. Please email your computer 
specification to Quintic for clarification. 
 
 Crosshairs 
 
During calibration or digitisation, the cursor should be a crosshair as shown 
below: 

 
Crosshair cursor 
 
However on some make of laptops e.g. DELL, this defaults to a text select icon as 
shown below: 

 
Text select cursor 
 
If you have experienced this problem, could please contact Quintic 
(info@quintic.com with your contact details, version of Quintic and the type and 
model of laptop/computer. Many thanks. 
 
Quintic are striving to correct this problem and recommend users in the 
meantime to change the default cursor within the windows control panel.  
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1. Go to control panel, mouse, pointers.  

 
 
2. Highlight text select, click on browse, and select cross_l, click OK. 
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Quintic System Requirements

Quintic Biomechanics 9.03v11 & Quintic Coaching 4.01v11 
Minimum System Requirements 

• Windows XP Operating System 
• Pentium IV Processor 
• 2.0 GHz Processor with 512 Mb RAM (50/60fps capture) 
• 2.0 GHz Processor with 1024 Mb RAM (100fps capture) 
• 30 GB Free hard disk space (1GB for system Program - 9GB to store video files) 
• FireWire Port of Card for Quintic Single Capture 
• Firewire Card for Quintic Dual or High Speed Capture. Note Firewire Cards 

only necessary for laptops 
• Monitor resolution of 1024*768 pixels 
• CD/DVD Read/Writer 
• Digital Camcorder DV Out 
• Basler High Speed Camera 
• Tripod 

Quintic Sports 1.08 System Requirements 
 

• Windows 2000/XP Operating System. 
• 700MHz Pentium III Processor with 128 MB RAM. (256MB recommended)  
• FireWire Port of Card for Quintic Single Capture  
• Monitor resolution of 1024*768 pixels. 
• 10 GB Free hard disk space (1GB for system Program - 9GB to store video files)  
• CD/DVD Read/Writer 

 
 

The Quintic Player System Requirements 
 

• Windows 95,98,NT,ME,2000,XP Operating System. 
• Pentium II Processor with 128Mb RAM. 
• CPU of 400 MHz or higher. 
• Windows Media Player v6.4 or higher. (Free download from Microsoft.com) 
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 Quintic Coaching CDs System Requirements 
 

• Windows XP Operating System 
• CPU of 1GHz with 1256Mb RAM 
• 1Gb Hard Disk Space 
• 1024*768 Screen Resolution  
• CD/DVD Rom Drive 
• Windows Media Player v6.4 or higher. (Free download from Microsoft.com) 

Quintic Camera Requirements 

• PAL / NTSC Mini DV Camcorders.  
• Firewire port / IEEE – 1394 / i.Link  
• Firewire cable for Quintic Single Capture – 4 to 4 pin or 4 to 6 pin.  
• Firewire cable for Quintic Dual Capture – 4 to 6 pin  
• Firewire cable for Quintic High Speed Capture – 6 to 6 pin.  
• Shutter Speed Settings – Sports setting required.  
• Lens – 0.8 Mega Pixel Lens.  
• Tripod attachment for Live Capture.  
• Basler Monochrome Camera – Quintic High Speed Capture.  

Additional Quintic Camera Requirements 

• DV IN port – for capturing footage from DVD or VHS.  
• Manual Shutter Speed Settings.  
• Lens – 0.8 + Mega Pixel Lens.  
• C-Mount Lens for Quintic High Speed Capture.  

 

To operate the Quintic Software you will need a personal computer, a digital video 
camcorder.To capture digital video files onto your personal computer you will    
require a FireWire Card along with a FireWire Cable. The FireWire Card fits into 
your computer and transforms the digital signal from your digital camcorder into a 
format, which can be processed by your computer.  

The FireWire Cable connects the DV port (Digital Video) from your digital                
camcorder to the external port of your computers FireWire Card. Some computers   
come with an inbuilt FireWire Card and so all you will require is a FireWire Cable.   
Sony VAIO Notebooks and Desktops, Dell, Toshiba and Sharp Laptops are examples 
of computers that come with FireWire Cards.  

FireWire cards are often referred to as FireWire PCI cards IEEE-1394 or i.Link
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Frequently Asked Questions

Q1: How long has Quintic been in business?  
A: Quintic Consultancy Limited was started in 1997 by Dr Paul Hurrion PhD BA 
(Hons) and Dr Robert Hurrion PhD MSc(Econ) BSc(Hons) and has grown 
steadily and successfully into a major force in Biomechanical Analysis & 
Consultancy and Performance Analysis Software across the world in Sport, 
Education, Health and Fitness.  

Q2: Where is Quintic? 
A: In the centre of England close to Birmingham International Airport and The 
Belfry.  

Q3: Who are Quintic’s customers?  
A: Quintic provides Software to private individuals, clubs, businesses, national 
and international sporting bodies, and health services across the world. See some 
of our many impressive patrons at www.quintic.com/links_page.htm and at 
www.quintic.com/quinac

Q4: Apart from Performance Analysis Software and Coaching CDs what else 
does Quintic do? 
A: Quintic undertakes Biomechanical Consultancy; has a top level personal Golf 
Putting Analysis Laboratory; undertakes Biomechanical Lectures; and directly 
assists National and International Review and Coaching Panels. 

Q5: What does “Quintic” mean?  
A: A Quintic Spline is a mathematical term for a line through points on a graph 
frequently used in mathematical calculation of speeds and accelerations.  
 

Choosing Quintic 

Q6: Which is the right Quintic Software for me?  
A: It is best to study the different features and consider how they apply to your 
anticipated usage. The features of each product are shown in a helpful table near 
the foot of the www.quintic.com/software page and it is a good idea to print a 
copy for reference as you study the Quintic Products.  

Q7: Why do you sometimes refer to Software and sometimes to CDs? 
A: We refer to Quintic Lite, Quintic Sports, Quintic Coaching and Quintic 
Biomechanics as “Software” and to Quintic Coaching CDs as “CDs” to distinguish 
the different types of product? “Product” refers to both types.  
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Q8: How do Quintic Coaching CDs differ from Quintic Software? 
A: Quintic Coaching CDs are full and complete coaching manuals, with hundreds 
of pages and videos of advice, that can be used both on a read only basis and with 
video capture and basic analysis tools - they are licensed to TWO computers. 
Quintic Software systems are performance analysis tools into which you capture 
video action for editing, viewing, comparison and analysis - they are licensed to 
ONE computer only.  

Q9: Why should I choose Quintic Performance Analysis Software? 
A: Quintic Software has been designed specifically around the needs of our wide 
range of clients and, whether amateur or professional, we believe the practical 
usage and benefit and the range and pricing of our products cannot be beaten. Just 
look at the range and importance of our customers [see Q:3].  

Q10: Why should I choose Quintic Coaching CDs? 
A: They are unique, tremendously useful and professional coaching tools that 
allow video capture and comparison - and they are inexpensive.  

Q11: Are Quintic Products easy to use? 
A: Quintic Products: are straightforward to use; are modular so each product 
operates in a similar way; contain all you need to know in comprehensive 
Tutorials and step by step Help Guides.   

Q12: How many computers can each Quintic Product be installed on? 
A: Quintic Software is licensed to one personal computer only. Quintic 
Coaching CDs are licensed to two personal computers.  

Q13: Will Quintic Products perform on an Apple Macintosh computer? 
A: Although designed to work with Microsoft Windows, Quintic Products are 
supported by an Apple Mac running Virtual PC with a suitable Windows 
Operating System.  

Q14: What are the special features of Quintic Products that will enhance my own 
coaching practice and add benefit to my clients? 
A: The Features Table [see Q:6] gives a guide to all of the features of the different 
Products. They will assist you to a most comprehensive analysis and enable you to 
demonstrate to clients more effectively and visibly. Also you can provide a 
performance CD for clients to take away [see Q:16].  

Q15: What advantages do Quintic Products offer above a video editing tool? 
A: You can create a database of performances; compare previous or best practice 
with current performance; analyse single or serial performances with drawing 
tools; use synchronised split screens and blended images; calculate speeds, 
accelerations and angles; capture at 50 fps (frames per second) PAL European 
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Standard or 60 fps NTSC USA /Asia Standard; transfer digitised data into Excel 
….. and much, much more – see the features table [see Q:6].  

Q16: What is The Quintic Player? 
A: It is the program for playing videos produced via the Quintic Software. It is 
added to CDs of selected files to allow them to be played at normal speed, slow 
motion, frame advance, or loop, with zoom and full screen options, and the active 
memo pad feature to read any notes you have saved with the original clip. The 
Quintic Player allows operation with Windows 95 upwards and your own logo 
can be added to the opening window as a reminder to clients.  

Q17: What is Quintic Playlist? 
A: An advanced editing suite that enables easy editing of long passages of video. It 
is particularly useful in Team Sports and, for example, the playing of bouncers in 
cricket, or dead ball kicks in football, or playing the lob in tennis can be extracted 
for analysis.  

Q18: Where Quintic Software is used in Podiatry and Physiotherapy, can it 
synchronise with a force plate? 
A: Yes – Quintic and RS Footscan have developed synchronisation software 
enabling video captured through Quintic Biomechanics and images from the RS 
Footscan Force Plate to be viewed contemporaneously via twin windows.  

Q19: What is digitisation? 
A: Digitisation is available only with Quintic Biomechanics. It converts movement 
into data to produce: graphical and numerical explanation; transfer of data to 
Excel for analysis and demonstration; and allows calculation of speeds, 
accelerations, and angles. This is most useful in Sports Science Studies, Podiatry 
and Physiotherapy, and top level sporting achievement.  

Q20: What support does Quintic provide after I have purchased a Quintic 
Product? 
A: Your Tutorials and Help Guide provide permanent and easy to follow 
support.  
A: Maintenance Contracts which include upgrades and personal support are 
available on an annual contract - please enquire.  
A: Consultancy and Training are available by the day on site or at Quintic - please 
enquire.  
A: Quintic runs Training Clinics.  
A: Upgraded software - also see Q:21.  
A: Email support via info@quintic.com 
A: A commitment - Quintic want you to get the best from Quintic Products.  
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Q21: How often will the Software be updated / upgraded with new additions 
formats etc.? Are these free? 
A: Quintic continuously enhances its Products to meet customer requirements 
and changing industry standards and developments.  
A: All upgrades to Software are free to registered users within 6 months of 
purchase. After 6 months, upgrades to Quintic Software are charged at 25% of 
current retail price. 
A: There is an option for clients purchasing Coaching & Biomechanics Software 
to enter into an Annual Maintenance Contract at 15% of current retail price. This 
includes free upgrades, training & support, for further details please visit 
www.quintic.com/pricelist 
 

Buying Quintic Products 

Q22: What about the prices of Quintic Products? 
A: This is an obvious consideration and decisions will be based on personal and 
professional needs. There is a wide range of Products to suit all budgets. The 
prices of Quintic Lite, Quintic Sports and Quintic Coaching CDs are shown in the 
Online Shop. For Quintic Biomechanics and Quintic Coaching - please enquire 
through our Contact page at www.quintic.com/contact_us 

Q23: If I am buying on behalf of, say, a Medical Practice or College or Sports 
Club, and need several licences, is there any special price? 
A: Yes - Quintic Multi-site Licensing prices are both popular and advantageous – 
please tell us your likely requirements through our Contact page for an instant 
quotation.  

Q24: What if I buy, say, Quintic Sports but then decide I want Quintic Coaching? 
A: Quintic allow you to upgrade software within 12 months of purchase and 
will refund your original purchase price against the cost of the new product for a 
nominal administrative charge.  

Q25: How quickly does Quintic deliver? 
A: Quintic Lite and Quintic Sports can be purchased with a credit card through 
our Online Shop and downloaded for instant use. Quintic Coaching CDs Quintic 
Coaching and Quintic Biomechanics are sent within 7 days.  

Q26: Does Quintic deliver worldwide? 
A: Yes. For Coaching CDs post & packing is the same nominal price in the UK 
and all over the world – see our Online Shop for details. For Quintic Coaching 
and Quintic Biomechanics post & packing is free. Quintic Sports and Quintic Lite 
are downloaded via the internet for immediate use [or on disc if required subject 
to an extra charge].  
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Correct Supporting Hardware & Media Components. 

Q27: What are the computer system requirements to support Quintic Products 
effectively? 
A: Both minimum and recommended requirements are set out for each product 
on our website at www.quintic.com/system_requirements.htm  

Q28: Is there anything specific my desktop computer should have? 
A: The free flow of data between camera and PC is vital. A desktop PC will have 
[or can have installed] a direct FireWire Card [IEEE 1394 or i-Link] interface and 
port. Many PCs such as Sony have the interface as standard. See the Sony-Quintic 
hardware packages and get advice and assistance at www.quintic.com/hardware.

 

Desktop Firewire Card + 6pin to 4pin FireWire Cable 

  

Q29: Is there anything specific my laptop computer should have? 
A: The free flow of data between camera and PC is vital. A laptop that has a 
direct FireWire [IEEE 1394 or i-Link] interface and port is best. This works more 
efficiently and has a faster transfer rate than a separate FireWire Card. Many 
laptops such as Sony have the direct interface as standard. A Firewire Cable must 
always be used. See the Sony-Quintic Hardware Packages and get advice and 
assistance at www.quintic.com/hardware. 

 

Laptop Firewire + Camcorder + 4pin to 4pin Firewire Cable 
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Q30: Is the data flow rate /transfer rate /bit rate that important? 
A: Yes – it requires a high rate to support capture at 50 fps particularly if the 
moving target is large as with close-ups. Quintic do not guarantee good capture 
performance at 50 fps if a direct FireWire [IEEE 1394 or i-Link] is not used.  

 

An external 'FireWire' Card that fits into the PCI MCIA Port on the laptop -  
suitable for Capture with the Quintic software.  

Q31: Which is the best video camera for me to use with the software and 
hardware? 
A: Generally an expensive camera performs better than a cheap one but it is a 
personal balance between required usage and price. The video camera / 
camcorder must be digital with DV IN/OUT (IEEE 1394 / i-Link / Firewire 
port), a Sport setting, a shutter speed of at least 1/1000th second and a quality 
lens. We use Sony cameras – see the Quintic Hardware Packages and get advice 
and assistance through www.quintic.com/hardware. 

 

Sony Camcorder + Tripod + FireWire cable 
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Camcorder + Tripod + FireWire cable 

 

High Speed Camera +  

                                                                                                   6-pin FireWire port 

Q32: Which is the best High Speed camera for me to use with the software and 
hardware for capture at 100 fps? 
A: Quintic Video Capture Software is compatible with Basler High Speed 100fps 
Cameras. Visit the Quintic Hardware Packages and get advice and assistance 
through www.quintic.com/hardware.  
 
Q33: Will I need any Software Utilities to run Quintic Products and how do I 
get them? 
A: Yes – to run Quintic Products properly your PC must have Video CODECS; 
DirectX; & Windows Media Player loaded and installed. If your PC does not have 
them then the latest versions of each are available free from 
www.microsoft.com/downloads/. [Microsoft XP includes DirectX and Windows 
Media Player] If your PC does have them loaded then you should make sure they 
are installed by locating and double clicking the relevant program file via My 
Computer >C:Drive >My Programs.  
 

Using Quintic Performance Analysis Software 

Q34: What sort of files does Quintic use?  
A: Quintic Products use only AVI files. Other types of files must be converted to 
AVI for use in Quintic Products if necessary via software such as Adobe 
Premiere.  

Q35: What does “Uninstall” mean?  
A: Through Quintic Security each licence is dedicated to recognise one computer. 
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Any change in or of that computer means the software will not recognise it and 
therefore not function. To allow for changes Quintic Security allows you to 
uninstall the software twice in any 12 months and reinstall it on the changed 
computer. NB – Change means a change of components within a computer or a 
change to a different computer.  

Q36: If I change my computer, how do I Uninstall the product to be able to use it 
on the changed computer?  
A: There is an automated system for which the computer must be connected to 
the internet then - with Quintic software via the “Help” menu - with Quintic 
Coaching CDs via the “Using this Manual” section select “uninstall” and follow the 
simple instructions. Quintic Uninstallation Software Security Window  

 

Quintic Uninstallation Software Security Window 

 Q37: I have just uninstalled Quintic Lite and Quintic Sports from my old PC and 
received my D code but my software was originally downloaded via the 
internet. How do I install the Quintic program on my new PC?  
A: In the same way as the original download - go to our website Members Forum 
http://www.quintic.com/members_forum/ enter your details and use the 
password you received originally, then follow the instructions.  

Q38: Is it easy to learn how to use the software?  
A: Yes. Quintic Software has Tutorials and a complete Help Guide. You 
should read through the Tutorials and Help Guide to gain an overview and 
familiarise yourself with the various functions, and then work practically through 
the Tutorials as you start to use the software. With Quintic Coaching CDs 
there is a “Using this Manual” section, a Help Guide, and further instructions in 
the Capture section. Quintic Tutorials Shortcut icon  
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Quintic Tutorials Shortcut icon 

 Q39: Is it easy to change from using, say, a Coaching CD to Quintic Sports?  
A: Quintic Products are modular and so operation of each version is similar.  

Q40: What if I have the wrong Font Size? 
A: This will prevent you from seeing the icons clearly. You will need to make a 
change via My Computer >Display Properties >Settings >General Display > 
Normal size > 96DPI .  

Q41: What Screen Setting should I use to have the correct window size on my 
screen? 
A: You should use the general setting of 1024X768 [make changes via >start 
>My Computer > Control Panel / Settings > Appearances /Display >Change 
Screen Resolution].  
Note: Scrollable Windows allow for maximum screen usage. Maximum Screen 
Resolution 1600x1200 for desktops & laptops or even wide-screen 
configurations. 
 
Q42: Will I have problems if my hard drive starts to fill up? 
A: Possibly – you may not have space to store video; and the sample AVI file 
footprint on the hard drive could be compromised. Defragmentation of the hard 
drive should resolve this – select Start >All Programs >Accessories>System 
Tools> Defragment – it can take a while and is worth doing overnight.  

Q43: How do I put clients' files onto a CD for them to use with The Quintic 
Player? 
A: With Quintic Software Systems you are licensed to distribute The Quintic 
Player free of charge. Within the Software is the 'Burn to CD' function that 
enables you to send any analysed videos & The Quintic Player to the computer 
CD drive. See our Online Tutorials for more information on this function 
www.quintic.com/tutorials

Q44: How do I email a clients' files for them to use with The Quintic Player?  
A: With Quintic Software Systems you are licensed to distribute The Quintic 
Player free of charge. Within the Software is the 'Instant Email' function that 
enables you to email any analysed videos & The Quintic Player to your clients 
inbox. See our Online Tutorials for more information on this function 
www.quintic.com/tutorials
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Q45: When I use Export Analysis the colours in the exported video file have 
become inverted.  How do I correct this? 
A: This problem has been discovered on Toshiba laptops and computers with a 
graphics card of 16MB. Go to C drive > Program Files > Quintic > Right click 
on Exportavi.exe. Select properties > Select compatibility > Display Settings 
>Tick 'Run in 640x480 screen resolution' 

Q46: Why can't I play a video in the Main and Best windows within the Coaching 
CD’s? 
A: Open Display Properties in Control Panel. [click Start, click Control Panel, 
click Appearance and Themes, and then click Display]. Click the Settings tab, 
click Advanced, and then click the Troubleshooting tab. Drag the Hardware 
acceleration slider to the left. (if you place the slider in the middle this should be 
sufficient to solve the problem). Click OK, and then click OK again. Restart the 
computer when you are prompted to do so. 

Q47: Why do I get an Error message “De-interlacing filter not installed” is shown 
when you try to play a video within Quintic? 
A: This indicates an error during installation and set-up, for example the AVI 
Synth file has not run. Run your PC with no applications open. Go to Start > My 
Computer > Main Hard Drive :C (or other main drive) > Program Files > 
Quintic > AviSynth. Open AviSynth and click through the set up process - it's 
very quick. Then Restart the PC. 

Q48: What does it mean if I get the Error message "Incorrect video format ". 
A: The ”Incorrect video format " message usually indicates that the Video Codecs 
utility is not running. The Codecs file is provided on the Quintic CD and will 
have loaded but it is not running. To run it, go to the actual file via Start >My 
Computer > CDrive > Program Files > Quintic > Codecs and click to run it -
 choose the Reinstall All Components option when you get there.  
If there is still a problem then it may be that the "user account" where the 
programme is installed in does not have full Administrator Rights. The software 
does need full Administrator Rights to access the necessary utilities etc.  If that is 
the case then Remove and reinstall in a User Account with full Administrator 
Rights. 

Q49: Why when the Quintic windows are resized are certain buttons hiding? 
A: To solve this close all currently running programs. Right click on the desktop 
and select 'Properties'. Click on the 'Appearance' tab > Select the first drop 
down menu under the heading 'Windows and buttons’ Select 'Windows 
Classic style'. Press the Apply button. You may also have to restart your 
computer.  
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Using Quintic Capture Software 

Q50: Is there any need to use any other Capture or Editing software?  
A: No – Quintic Products incorporate all necessary editing and capture 
software.  

Q51: What are the basic fundamental practices of video capture I need to be 
aware of to ensure my practices are consistent with this coaching tool? 
A: Please have a look at the Benefits of Video section on our website at 
www.quintic.com/benefits_of_video.htm

Q52: Will I have to capture my own video straightaway to practise with the 
software? 
A: No – Quintic provide short clips of sporting action online at the following 
page: www.quintic.com/software/sample_videos and also provide a Sample 
Video Library on disk with your software.  

Q53: What is a FireWire / 1394 / IEEE 1394 / i-Link? 
A: All these terms refer to the IEEE 1394 standard defining a high-speed mode of 
transmission that guarantees bandwidth for connections between computers and 
digital video cameras. The FireWire Card in the computer and the FireWire cable 
are the two necessary components.  

 

4-pin to 4-pin (Laptop - Camcorder) / 6-pin to 4-pin (Dual Capture) / 6-pin to 
6-pin (High Speed Capture)  

 
Q54: Why are there 3 different types of FireWire Cable, and which one should I 
buy? 
A: FireWire cables vary depending on whether or not your camera requires 
power from the computer to operate it.  
A: Quintic Single Capture requires a digital Camcorder & 4-pin to 4-pin FireWire 
Cable. 
A: Quintic Dual Capture requires 2 digital Camcorders & 4-pin to 6-pin Firewire 
Cables. 
A: Quintic High Speed Cature requires a Basler Camera & 6-pin to 6-pin 
FireWire Cable.
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Q55: Is there much practical difference between the capture speeds of 25 fps 
(frames per second) PAL European Standard (= 30fps NTSC USA /Asia 
Standard) 50 fps (= 60 fps NTSC) and 100 fps? 
A: Yes, the higher the frame rate the more information there is to analyse. This is 
very important for seeing and analysing technique in fast moving sports – for 
example a golf swing or a cricket bat. Only Quintic Coaching and Quintic 
Biomechanics have the option to produce videos at 50(60) & 100fps.  

Q56: What size AVI file does Quintic capture for analysis? 
A: A typical Quintic AVI file of 15 seconds in duration at 25fps is 1Mb, 5 seconds 
in duration at 50fps is 1Mb & 3 seconds in duration at 100fps is 1Mb. These are 
ideal for analysis or distribution via The Quintic Player or internet /email. The 
standard Microsoft AVI size maximum of 2Gb must not be exceeded or the 
sample AVI footprint on the Hard Drive will be invalidated.  

Q57: Are there common problems when capturing and analysing video? 
A: Not carefully following the Tutorials / Instructions.  
A: Media Components not loaded or loaded but not installed. 
A: Wrong capture settings – see Tutorials. www.quintic.com/tutorials 
A: Not using a firewire card / firewire cable. 
A: Insufficient capacity in the PC. 
A: Not having the camera steady on a tripod – see Tutorials.  
A: Poor battery power on laptops – mains power will optimise laptop 
performance.  

Q58: Why is it dropping frames during the capture process? 
A: Your computer may not be powerful enough or close to capacity. Ensure that 
you have followed the Set Up option within the Video Capture Software. Help on 
how to do this can be seen at www.quintic.com/tutorials within the Appendices. 
A: Defrag the computer by right clicking on the D or C drive and selecting 
‘Properties’ Select the ‘Tools’ and then select the defrag option. Allow the 
computer to defrag both drives and then restart your computer.  

Q59: Can I use existing footage from video tapes? 
A: Yes – with your DV In/Out Camcorder using a SCART lead with an in/out 
switch via the TV / VCR. See www.quintic.com/benefits_of_video.htm for 
more information  

Q60: How can I enquire or ask more questions?  
A: We shall be pleased to respond to your enquiries and questions through our 
Contact page : www.quintic.com/contact_us/.
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Glossary of Technical Terms associated with 
Quintic Products

Active window: The window that you are currently using or that is currently 
selected. Only one window can be Active at a time, unless the synchronisation 
function is being used. The Active window has a dark blue border along the top of 
the screen. The current file name and directory is displayed in the title bar at the 
top of the window.  

AVI: Audio Video Interleave : the format of the video files needed to run within 
the Quintic software.  

Compression: Video files can be large. Compression reduces their size with 
negligible loss of quality.  

Directory or Folder: Part of a structure for organizing your files on a disk. 
Directories/Folders are an extremely useful tool, allowing you to group related 
files together in the same directory/folder for easy access. When you select a 
particular directory/folder, the files it contains are instantly displayed.  

Double click: To twice press and release quickly the left (usually) mouse 
button.  

Drag mouse: Press and hold down the left mouse button while moving the 
mouse - for drawing lines and angles within Quintic Products.  

Draw: To mark on a frame of a video file using options under the Draw Menu - 
Line drawing / freehand drawing.  

Drop down Menu: A menu that opens from a command on another menu. A 
command that opens a cascading menu has a right arrow next to it: for example 
Digitisation : Set step size 1, 5 or 10. 

FireWire / 1394 / IEEE 1394 / i-Link: All these terms refer to the IEEE 1394 
standard defining a high speed mode of transmission which guarantees bandwidth 
for connections such as between computers and digital video cameras. A FireWire 
and firewire cable must be used with Quintic Products 

Filename: The name given to a file of information on disk.  

Frame: One still picture from a video file. Individual frames or a sequence of 6 or 
12 frames may be captured within the program and printed out within a word 
document. This function is ideal for reports.  
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Hard Disk / Drive Capacity: This is the amount of storage space on your 
computer  

Inactive window: A window that is not currently being used. The next 
movement by the mouse action or keyboard will not affect its contents. An 
inactive window can be activated by clicking on it.  

Markers: 10 markers are available to the user. This enables 10 frame numbers to 
be chosen by clicking on the marker icon. The video clip that contains a frame 
number chosen by selecting markers can be saved. Any previously saved markers 
will default on when opening the relevant video clip. By marking a video frame, 
you can easily return to that frame by clicking on the marker tag. It is possible to 
reset all 10 markers, or each marker can be reset individually by placing the 
cursor over the marker tag and pressing the CTRL key.  

Play: To initiate the play of a video file, either through its entire sequence of 
frames or frames specified using Main file menu. There is a shortcut key to play a 
video clip on the toolbar.  

Scroll Bar: To move through a video clip frame by frame using the scroll bar.  

Screen Resolution: Settings of the monitor, the Quintic system best runs on a 
screen setting of 1024 x 768 pixels.  

Title Bar: The blue horizontal bar at the top of the monitor screen that contains 
the number of the open window, the title of the system and the name of the 
current file.  

Toolbar: A menu of quick selections (icons) across the top of the monitor screen 
and below the menu bar. The items in the toolbar are the most commonly used 
features in the Quintic System and are available by clicking the mouse on the 
desired icon.  

Trace: Marking the position of a point or object frame by frame through a video 
file - creating a point trajectory.  

Video file: A video clip that has been given a name and is stored on the disk. 
This file can be accessed by selecting Open Video under the File Menu. Quintic 
Products use only *.avi files.  

Window: A framed area on the computer screen within which you may place a 
file for manipulation. Quintic allows you to open one or two windows, but only 
one window may be active at a time unless you are using the synchronisation 
mode. 
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Glossary of Biomechanical Terms 
KINEMATICS  

MASS 
The quantity of matter in an object. The mass of an object will, remain constant 
regardless of location or gravitational conditions (e.g., earth or moon gravity). 
The importance of mass in mechanics is that it represents, in linear terms, the 
resistance to a change of state (a speeding up or slowing down).  The unit of mass 
is the kilogram (kg). 
 
CENTRE OF MASS 
The point at which the mass of the body acts (the point representing the mean 
position of the matter in a body). 
 
KINEMATICS 
Description of motion of a body. 
 
LINEAR MOTION 
Motion in which all parts of the body travel along parallel paths. 
 
ANGULAR MOTION 
Motion in which a body travels along a circular path; all parts of the body travel 
though the same angle, in the same direction, at the same time. 
 
SCALAR 
A quantity that only has magnitude, for example, mass, and length, are both scalar 
quantities. 
 
VECTOR 
A quantity that has both direction and magnitude. A force, for example, is always 
described by its size and by the direction in which it is acting. Velocity is also a 
vector quantity because it expresses the rate of change of position in a given 
direction. 
 
DISPLACEMENT 
The change in the position of a body. 
 
VELOCITY 
The rate of change of displacement. 
 
ANGULAR VELOCITY 
The rate of movement in rotation. 
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ACCELERATION 
The rate of change of velocity with respect to time. 
 
ANGULAR ACCELRATION 
Angular acceleration refers to the rate at which the angular velocity of a body 
changes with respect to time. 
 

FORCES 
 
FORCE 
A vector quantity that describes the action of one body on another. 
 
MOMENT ARM 
The perpendicular distance from the point of application of a force to the axis of 
rotation. 
 
LEVER 
A lever is a system that tends to change the mechanical advantage of an applied 
force. Basically, it consists of two forces and a fulcrum or hinge. The two forces 
are called an effort force (such as a muscular force) and a resisting force (such as a 
weight held in the hand or a ground reaction force). The perpendicular distance of 
each force from the fulcrum is called the lever arm. 

 

 

 

      a) First Class Leve

On opposite sides of t

 

       b) Second Class Lever       

On the same side of the fulcrum with 
resistance arm closer to the fulcrum.  

 
 

 

 

 

r 

he fulcrum. 
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  c) Third Class Lever 
 
On the same side of the fulcrum with               
the effort force closer to the fulcrum. 

 
 
 
 
 
 
 
 
 

 
GROUND REACTION FORCE 
The forces that act on the body as a result of interaction with the ground. 

 

GRAVITATIONAL FORCE 
The force exerted on an object as a result of gravitational pull. 
 
g 
The symbol used to represent the acceleration because of gravity on earth. 
Although this quantity actually varies according to location and altitude, the usual 
value used is 9.81 m/sec2  
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KINETICS 
 
NEWTONS LAWS 

1. Newton’s first law states that a body will maintain a state of rest or 
uniform motion unless acted on by a net force. 

2. Newton’s second law states that the change in momentum of the body 
under the action of a resultant force will be proportional to the product of 
the magnitude of the force and the time for which it acts (i.e., the 
impulse). The second law also states that the change in momentum will be 
in the direction of the resultant force. 

3. Newton’s third law states that action and reaction are equal and opposite. 
 
LINEAR MOMENTUM 
The product of the mass of an object and its linear velocity. 
 
ANGULAR MOMENTUM 
The rotational equivalent of linear momentum that can be thought of as describing 
the "amount of motion" that the body possesses during rotation. 
 
WORK 
Work (W) is done when a force moves an object through a distance. Whenever a 
constant force exists and motion takes place in a straight line, then work equals 
the magnitude of the force (F) times the distance (d) through which the object 
moves  
(W = F d). 
 
POWER 
The rate of doing work. Power (P) is equal to the work done divided by the time 
during which the work is being done: P = W/t. 
 
ENERGY 
The capacity for doing work. In any system, this capacity cannot be destroyed, 
but energy can be transformed from one form to another. 
 
KINETIC ENERGY 
That component of the mechanical energy of a body resulting from its motion. 
 
POTENTIAL ENERGY 
That component of the mechanical energy of a body resulting from its position. 
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MUSCLE MECHANICS 
 
CONTRACTION 
Development of tension by a muscle whether or not shortening is underway. 
 
MUSCLE ACTION 
The development of muscle tension (more appropriate than the term 
"contraction"). It can be applied to any type of tension development regardless of 
whether a muscle is lengthening, shortening, or maintaining the same length. 
 
ECCENTRIC MUSCLE ACTION 
Muscle lengthening under tension. This lengthening occurs when the external 
force acting on the segment to which a muscle is attached causes a net moment 
that is greater than the moment that is being developed by the muscle and its 
synergists. 
 
CONCENTRIC MUSCLE CONTRACTION 
Muscle shortening under tension. This shortening occurs when the net moment 
developed by a muscle and its synergists is greater than the moment caused by the 
external forces acting on the segment to which the muscle is attached. 
 
ISOMETRIC CONTRACTION 
Muscle action that involves no change in length of the muscle the action of a 
muscle when no change exists in the distance between its points of attachment—
referring to the joint and not to the muscle. 
 
ISOTONIC CONTRACTION 
Muscle action that involves the production of a constant force. 
 
ISOKINETIC CONTRACTION 
Muscle action in which the rate of shortening or lengthening of the muscle is 
constant.  
 
ORIGIN 
The source or beginning of a muscle. The term generally refers to the more fixed 
end or the more proximal end. 
 
INSERTION 
The more distal attachment of the muscle or the attachment that is more mobile. 
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TENSION- LENGTH RELATIONSHIP 
The variation in force output of a muscle, with the same neural input, over a 
range of lengths. The reasons for this variation include a change in the number of 
possible active sites for cross-bridge formation and the effect of the elastic tissues 
that are in parallel with the contractile tissue. 

 
 
FORCE – VELOCITY RELATIONSHIP 
At any given length, the speed of shortening or lengthening of a muscle that is 
stimulated at a constant level will depend on the force that is applied to the ends 
of the muscle. The Hill equation, best known of the force-velocity equations, 
describes mathematically the fact that light loads can be lifted quickly but heavy 
loads only slowly. Although it is often stated that maximal muscle force is 
available at zero velocity (isometric action), the highest loads are achieved during 
eccentric muscle action. 

 

Force 

 
 
 

                            Velocity 

 

Concentric Eccentric 

   Isometric 

Maximum 
shortening 
velocity 

Maximum 
lengthening 
velocity 
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Quintic Sports Science 

What is Biomechanics?

The word 'biomechanics' is derived from the Greek bios meaning 
life and mekhaniki meaning mechanics, so that biomechanics may 
said to be the study of the mechanics of life forms. The extent of 
this subject area is evident in research of plants, insects, reptiles, 
dinosaurs, birds, fish, whales, elephants, kangaroos and humans. In 
the biomechanics of humans, topics range from the mechanics of 
bone, tooth, muscle, tendon, ligament, cartilage, skin, prostheses, 
blood flow, air flow, eye movement, joint movement to whole 
body movement. In human movement biomechanics, topics include 
injury, clinical assessment, rehabilitation, ergonomics and sport.  

Sports biomechanics uses the scientific methods of mechanics to 
study the effects of various forces on the sports performer. It is 
concerned, in particular, with the forces that act on the human 
neuromusculoskeletal system, velocities, accelerations, torque, 
momentum, and inertia. It also considers aspects of the behaviour 
of sports implements, footwear and surfaces where these affect 
athletic performance or injury prevention. Sports biomechanics can 
be divided up into two sections:

 

 

 

 

 

 

 

 

 

 

 

Performance Improvement & Injury Prevention 

With the help of Quintic, we aim to provide answers to performance related 
topics: 

What is the best run-up for a high jumper?  

How should they knee angle be modified for the delivery stride of a fast bowler in 
cricket?  

What is the velocity of the swimmer after the tumble turn?  

These questions are of the form: What is done? How is it done? Why does it 
work? The answers to What? How? and Why? are important to the athlete, coach 
and scientist, respectively... 
 
 
"Biomechanics is the science concerned with the  
internal and external forces acting on a human body  
and the effects of these forces..."
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Example of Quintic Biomechanics in Rowing: 

From video footage of rowing tank training, the Quintic software enabled 
techniques of different rowers to be analysed and compared. Further to that, the 
Quintic Biomechanics enabled the velocity of the oar handle to be monitored and 
compared for the different rowers.  

 

 
The figure above shows a Quintic trace of the oar handle through two strokes. 
The analysis program calculates velocities and accelerations along this line, which 
can be directly analysed. The velocity and acceleration data displayed in the 
analysis program can be exported into a spreadsheet. This allows a more detailed 
and specific analysis to be conducted.  

The figure below shows an example of this. Two velocity traces of two different 
rowers, working at different stroke rates are compared below. The velocity traces 
are shifted in time so that the beginning and end of each stroke coincides. This 
enabled the direct comparison of velocity and acceleration. The velocity graphs 
below, generated from the Quintic Analysis program, show the higher speeds 
generated by Sarah in the driving phase of the stroke, and the significant 
difference in the velocities in the return phase. 
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How can a Sport Psychologist help you? 
 

 
 

Aspects of sports performance such as being able to control anxiety and the ability 
to stay focused at crucial times often dictate whether an individual is successful or 
not. However, very little time is spent working on the mental game. Mental skills 
need to be worked on just as physical skills are. Many sports performers are able 
to perform to a high level in practice yet seem unable to ‘deliver the goods’ when 
they compete. 

There are many myths about Sport psychology. 
What does a Sport Psychologist actually do? The 
reality is that applied Sport Psychology is based 
on very simplistic principles. One principle 
endorsed by many practitioners is the KISS 
approach (Keep It Simple Stupid !!). 

Such an approach is important as many 
individuals experience problems with their 
mental game simply because they ‘over 
complicate’ things. Part of the Sport 
Psychologist's job is to simplify an individual's 
approach to the mental game, so that they feel 
‘in control’ of their performance.  

Much of what we do in Sport Psychology is 
taken from the experiences of those individuals 
who have made it to the top of sport. There are 
many mental skills, which can be enhanced 
through mental training; these include… 

Controlling anxiety (nerves)  
* Visualisation,  
* Developing concentration,  
* Confidence building,  
* Performance analysis,  
* Positive thought control,  
* Improving body language, 
* Developing pre-performance preparation,  
* Goal setting. 
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Often the reason for this is that they have spent all their preparation time working 
on their physical game and neglected their mental preparation. Therefore, when 
they confront a pressure situation or they experience a loss of concentration they 
do not have the relevant coping strategies to stay in control of their performance. 
These individuals should be encouraged to spend time working on their mental 
game, to allow them to fulfil their potential physically by preparing mentally. 
Most individuals find that very simple mental strategies help them to feel more in 
control of themselves and subsequently perform to a higher standard.  

 What are the Psychological benefits of the Quintic System?  

The use of video analysis is important for a number of psychological reasons…  

1. Visualisation.  
Video analysis can help an individual to learn to visualise much more effectively. 
By observing yourself performing consistently well on video you can enhance the 
way that you see yourself perform in your mind. The use of video is particularly 
useful for developing external visualisation (where you see yourself performing as 
if on a television screen). This form of visualisation allows the individual to 
observe themselves performing from afar. Therefore, they do not experience the 
same thoughts, feelings and emotions that are felt when they visualise a situation 
through their own eyes. This form of visualisation is particularly important when 
building confidence and dealing with controlling anxiety.  

2. Positive Reminders.  
Most sports performers are encouraged to keep some kind of performance 
analysis diary. A diary can be used to assess the strengths and weaknesses of recent 
performances and can also be used as a positive reminder of good performances. 
The Quintic system allows the individual to keep a library of positive 
performances, which can be recalled simply at the touch of a button. Using the 
memo pad feature you can also recall any important information regarding the 
video clip that you are watching. For example a golfer can record a library of their 
best shots with each club. The memo pad allows you to record any important 
information regarding each swing, for example ‘swing keys’ or ‘swing thoughts’. 
Thus, if they are beginning to struggle playing with a particular club the golfer can 
recall an image of themselves playing at their best with that particular club. Using 
the split screen function the player can then record their current swing and 
compare it to their best swing. By using the synch function and running these two 
images together the player can establish whether there are any technical 
differences between the two swings. Any differences can be identified by the 
coach and drills can be worked out to correct the fault.  

"An example of the benefits of the Quintic system occurred when one particular 
golfer lost his confidence in swinging one particular club. When using the split 
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screen function the coach could not identify any technical differences between the 
golfers current swing as compared to a good swing recorded three months 
previously. It was clear that the golfer had simply lost confidence in their swing. 
By seeing that there were no technical differences between the two swings the 
golfer was reassured that their technique was not at fault. This put any 'technical 
doubts' out of the golfers mind and ensured that he believed in his technical 
ability. The memo pad feature also reminded the golfer of their ‘positive 
thoughts’ and ‘swing keys’. In this case the player had stopped using one 
particular swing key. The Quintic system had acted as a positive reminder for the 
golfer and helped him rebuild his confidence in his swing". 

3. Body Language. 
Through the use of video analysis sports performers can become much more 
aware of their ‘behaviour’. For example a tennis player might want to study their 
body language after points that they have won or lost. Equally it is useful for 
studying the body language of opponents. A coach can use the split screen facility 
to show examples of both positive and negative body language as compared to that 
of the player that they are working with.  

4. Skill Development. 
Because of the systems slow speed function, individuals can receive direct 
feedback about a skill they are learning, immediately after performing the skill 
itself. Therefore, throughout the learning process the player can see a visual 
picture of what they are actually doing. This is very important, as often 
individuals are not actually doing what they perceive themselves to be doing. By 
using the systems spit screen function the coach can have a visual representation of 
the skill being performed perfectly on one side of the screen and the current 
image of the performer on the other. Thus the performer can see where the 
adjustments need to be made to the technique in order to perform the skill 
correctly. For more complicated skill development the lines / angles function can 
be used to demonstrate the ‘fine tuning’ of technical development. Such a visual 
representation can build confidence throughout the learning process. 

Written by Dr Mark Bawden, Metaphorics Performance Consultants Ltd
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Conversion Chart 
 

Metres per Second > Miles Per Hour > Kilometres per Hour 
 
 

Metres/s Mph Kph  Metres/s Mph Kph 
0.50 1.12 1.80  22.00 49.21 79.20 
1.00 2.24 3.60  22.50 50.33 81.00 
1.50 3.36 5.40  23.00 51.45 82.80 
2.00 4.47 7.20  23.50 52.57 84.60 
2.50 5.59 9.00  24.00 53.69 86.40 
3.00 6.71 10.80  24.50 54.80 88.20 
3.50 7.83 12.60  25.00 55.92 90.00 
4.00 8.95 14.40  26.00 58.16 93.60 
4.50 10.07 16.20  26.50 59.28 95.40 
5.00 11.18 18.00  27.00 60.40 97.20 
5.50 12.30 19.80  27.50 61.52 99.00 
6.00 13.42 21.60  28.00 62.63 100.80 
6.50 14.54 23.40  28.50 63.75 102.60 
7.00 15.66 25.20  29.00 64.87 104.40 
7.50 16.78 27.00  30.00 67.11 108.00 
8.00 17.90 28.80  30.50 68.23 109.80 
8.50 19.01 30.60  31.00 69.35 111.60 
9.00 20.13 32.40  31.50 70.46 113.40 
9.50 21.25 34.20  32.00 71.58 115.20 

10.00 22.37 36.00  32.50 72.70 117.00 
10.50 23.49 37.80  33.00 73.82 118.80 
11.00 24.61 39.60  33.50 74.94 120.60 
11.50 25.72 41.40  34.00 76.06 122.40 
12.00 26.84 43.20  34.50 77.17 124.20 
12.50 27.96 45.00  35.00 78.29 126.00 
13.00 29.08 46.80  35.50 79.41 127.80 
13.50 30.20 48.60  36.00 80.53 129.60 
14.00 31.32 50.40  36.50 81.65 131.40 
14.50 32.44 52.20  37.00 82.77 133.20 
15.00 33.55 54.00  38.50 86.12 138.60 
15.50 34.67 55.80  39.00 87.24 140.40 
16.00 35.79 57.60  39.50 88.36 142.20 
16.50 36.91 59.40  40.00 89.48 144.00 
17.00 38.03 61.20  40.50 90.60 145.80 
17.50 39.15 63.00  41.00 91.71 147.60 
18.00 40.26 64.80  41.50 92.83 149.40 
18.50 41.38 66.60  42.00 93.95 151.20 
19.00 42.50 68.40  42.50 95.07 153.00 
19.50 43.62 70.20  43.00 96.19 154.80 
20.00 44.74 72.00  43.50 97.31 156.60 
20.50 45.86 73.80  44.00 98.43 158.40 
21.00 46.98 75.60  44.50 99.54 160.20 
21.50 48.09 77.40  45.00 100.66 162.00 
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Anatomical Movements 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 



Anatomical Movements 
 

 
 

 
 

 

Movement: Elbow Extension 
Start position: Elbow flexion 
Finish position: Elbow extension

Movement: Suppination 
Start position: Pronation 
Finish position: Suppination 

Movement: Forearm Pronation 
Start position: Forearm Suppination 
Finish position: Forearm Pronation 
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Movement: Shoulder Adduction 
Start position: shoulder Abduction 
Finish position: Horizontal Abduction 

Movement: Shoulder Abduction 
Start position: Horizontal Abduction 
Finish position: shoulder Abduction 

Movement: Shoulder Extension 
Start position: Neutral Shoulder position 
Finish position: Shoulder Extension 
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Movement: Shoulder Flexion 
Start position: Neutral Shoulder 
position 
Finish position: Shoulder Flexion 

Movement: Shoulder Adduction 
Start position: Horizontal 
Abduction 
Finish position: Neutral Shoulder 
position 

Movement: Shoulder Abduction 
Start position: Neutral Shoulder 
position 
Finish position: Horizontal 
Shoulder Abduction. 
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Movement: Outward Shoulder Rotation 
Start position: Inward Shoulder rotation 
Finish position: Outward Shoulder Rotation 

 
 

 
 

 

Movement: Inward Shoulder rotation 
Start position: Outward Shoulder Rotation 
Finish position: Inward Shoulder rotation 

Movement: Wrist Abduction 
Start position: Neutral Wrist position 
Finish position: Wrist Abduction 
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Movement: Wrist Adduction 
Start position: Neutral Wrist 
position 
Finish position: Wrist Adduction 

Movement: Wrist Extension 
Start position: Neutral Wrist 
position 
Finish position: Wrist Extension 

Movement: Wrist Flexion 
Start position: Neutral Wrist 
position 
Finish position: Wrist Flexion 
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Movement: Ankle Plantar flexion 
Start position: Neutral Ankle position 
Finish position: Ankle Plantar flexion 

Movement: Ankle Dorsi flexion 
Start position: Neutral Ankle position 
Finish position: Ankle Dorsi flexion 

Movement: Ankle Inversion 
Start position: Neutral Ankle position 
Finish position: Ankle Inversion 
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Movement: Ankle Eversion 
Start position: Neutral Ankle position 
Finish position: Ankle Eversion 

Movement: Hip Abduction 
Start position: Neutral Hip position 
Finish position: Hip Abduction 

Movement: Hip Adduction 
Start position: Neutral Hip position 
Finish position: Hip Adduction 
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Movement: Hip Flexion 
Start position: Neutral Hip position
Finish position: Hip Flexion 
 

n 
Movement: Hip Extension 
Start position: Hip Flexion 
Finish position: Neutral Hip positio
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Movement: Knee 
Flexion 
Start position: Knee 
Extension 
Finish position: Knee 
Flexion 

Movement: Knee 
Extension 
Start position: Knee 
Flexion 
Finish position: Knee 
Extension 
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Digitisation Templates 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



Digitisation Templates 
 

        
 
 

A digitisation template showing a 1point digitisation model 
 
 
 

   
      
 

A digitisation template showing a 4 point digitisation model 
 

Point 1 

Point 2

Point 1 

Point 1

Point 2

Point 3
Point 4 
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A digitisation template showing an 8 point digitisation model 

Point 3

Point 1

Point 4

Point 5 

Point 6 

Point 7

Point 8

Point 2
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A digi

Point 3 

Point 1 

Point 2 

Point 5 
Point 6 

 

Point 7 
Point 7
 
 

tisation template showing a 10 point digitisation model 

Point 4 

Point 8 
Point 9 
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A digitisation template showing an 18 point digitisation model 

Point 1 

Point 2 

Point 3 

Point 4 

Point 5 

Point 6 

Point 7 

Point 8 

Point 9 

Point 10 

Point 11 

Point 12 

Point 13 

Point 14 

Point 15 

Point 16 

Point 17 

Point 18 
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A digitisation template showing a 20 point digitisation mode 
 

Point 1 

Point 2 
Point 3 

Point 4 Point 5

Point 6

Point 7 

Point 8 

Point 9 

Point 10 

Point 11 

Point 12 

Point 13 

Point 14 

Point 16 

Point 17 

Point 18 

Point 19 

Point 20 

Point 1 
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Digitisation Model 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



Digitisation Model 
 

The below diagram shows an example of an 18 point digitisation model which 
takes into account all the major digitisation points on the human body. 
 
 
 
  

 

 

 

 

 

 

 

         Left Toe (Big toe)  15 
 1  Vertex of the Head
 
           7th Cervical Vertebra 2
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        Left Hip 4
        Left Glenohumeral 3
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10 Right Elbow
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11 Right Wrist
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12 Right 3rd Finger
 
16 Right Knee
 
17 Right Ankle
                Left Knee 13
                 Left Ankle  14
(Big toe) 
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Quintic Analysis 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

 



Quintic Analysis 
 

Linear Analysis 
 
ORIGIN 
 
The origin of the graphs can be set as relative or absolute. 
Relative uses the first digitisation point as the origin (0,0) and all measurements are relative to this 
point. 
Absolute uses the origin (0,0) bottom left hand corner of the screen. 
 
CALIBRATION 
 
All videos that are used in the Linear Analysis must be calibrated. This is a method of relating pixel 
distances on the video with an actual scale – i.e. metres, feet. Various options exist within the 
analysis screens for showing velocity as mps, feet/sec, mph and kph. 
 
SMOOTHING 
 
It is recommended that filtering is used to smooth the raw digitisation data. See Appendix K - 
Butterworth filters for more details. 
 
DISTANCE
 
Distance can be illustrated as horizontal, vertical and/or linear measurements. 
Horizontal is the horizontal distance from the origin (absolute or relative) 
Vertical is the vertical distance above the origin (absolute or relative) 
Linear is the actual distance of the digitisation point from the origin.  
Note:- horizontal and vertical distances can be positive or negative but the linear distance will 
always be positive. 
 
SPLINES
 
Splines are methods of fitting continuous curves through a series of data points. Quintic splines are 
then used to show the horizontal, vertical and linear distance graphs. It is the spline fitting that 
allows interpretation of distances between frames. 
 
VELOCITY 
 
The rate of change of distance gives velocity. If slight errors occur in distance measurements then 
these can be amplified in the velocity calculations. So an averaging method is used to help calculate 
velocities. The distance before each point and the distance after each point are used to get an 
average velocity. 
 
ACCLERATION 
 
The rate of change of velocity gives acceleration. Similar averaging methods are used to get average 
accelerations. 

Appendix K 

 



 
Angular Analysis 
 
The picture below shows the results for angle B2>C3>D4 
The angle of the ankle varies from approx 87° to a max of 120° degrees. 
 

  
 

IMPORTANT – All angles are measured using the standard anti-clockwise 
convention. I.e. the angle from B2 to C3 to D4 (in the anticlockwise direction). The 
angle of the ankle is in the range 87°-120°. 
 
Now look at the angle A1 to B2 to C3. This is a reflex angle and is in the range 255°-
310°. The reflex angle is now shown by default. 
 

  
 
To display the acute angle within the graphical analysis, select display from the menu 
and unselect Reflex Angles 
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Butterworth Filters 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 

 



Butterworth Filters 
 
 
It is important to smooth data, which has been produced by Quintic manual 
digitisation or automatic tracking. Markers are usually attached to a subject to 
make the digitisation process easier and more accurate, from these markers the 
digitisation of the subject can occur. Errors in the digitisation process are possible, 
for example, actual errors while digitising (when locating the marker using 
manual mode) or due to skin and muscle movement over a joint centre. It is 
important to smooth the data to try and eliminate these errors.  
 
A common method of smoothing data is to use Butterworth filters.  
These filters tend to reduce the ‘noise’ in any signal and hence are better at 
obtaining the true underlying trend in any data series. The typical time series data 
signals from any (human) movement tend to occur at low frequencies while any 
errors are more likely to be at much higher frequencies. Low Pass Butterworth 
filers reduce the ‘noise’ from high frequency signals but keep the low frequency 
signals.  
 
There are many other digital filtering methods such as Fourier smoothing 
although Butterworth filters are robust and tend to give good results when applied 
to data series for human movement.  

Appendix L 

Quintic uses a method that looks for the optimal smoothing of any data series by 
comparing the difference between the raw data and smoothed data while still 
retaining a smooth data series as output 
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Uninstall Quintic Software  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 

 



Uninstall Quintic Software 
 
Through Quintic Security each licence is dedicated to recognise one computer. 
Any change in or of that computer means the software will not recognise it and 
therefore not function. To allow for changes Quintic Security allows you to 
uninstall the software twice in any 12 months and reinstall it on the changed 
computer. NB – Change means a change of components within a computer or a 
change to a different computer. 
There is an automated system for which the computer must be connected to the 
Internet to use.  
 
To uninstall Quintic software off your computer please follow these step by step 
instruction, ensure you are connected to the Internet. 
 

1. Select the help tab off the main menu bar and left click on the help button as 
illustrated below. 

 

 
 

2. Highlight the Uninstall Quintic software and right click to start the unistallation 
process. 

 
 

 
3. A warning box will now be loaded asking you to confirm the continuation of 

the de-registering process. Right click on the yes button to continue the 
process. 
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4. The computer will now generate your original security Code A in the 5 

boxes at the top of the generated window. 
 

 
 
 
 
 

5. The next pop up window that is generated is your final chance to cancel the 
uninstall process, if you wish to continue right click on the ‘Yes’ button if 
you wish to cancel the process right click on the ‘no’ button. 
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Read the warning box 
located in the window 
after you have read this 
you have another 
opportunity to cancel 
the uninstall process. 
 
 
 
 
 
 
 
 
 If you wish to continue 
the uninstall process 
right click on the ‘Yes’ 
button. 



Ensure that you are connected to the Internet for this 
next stage. 

 

 

7.

6. 

 

 

Your Quintic software has 
now been disabled from 
your computer and will not 
run. Uninstall security code 
D has been generated. 
The generated D code must 
now be submitted to the 
Quintic website so that your 
original A code can be reset 
so that you may install the 
software on another 
computer. This is achieved 
by right clicking on the 
‘Uninstall Code D’ button 
or by accessing the website: 
Hwww.quintic.com/softwa
re_securityH
 

 
 The next window you see will ask you to type in you’re Security Code A and 

Uninstall Code D or to check that they are correct. After this has been done 
right click on the ‘Submit Uninstall Code D’ button 
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9. The uninstall process has now been completed and your Security Code A has been 
reset. You may now install the Quintic software onto another computer. We 
suggest that you go to START/SETTINGS/CONTROL PANEL/ADD-
REMOVE PROGRAMS to delete the Quintic software from the original 
computer. 
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8.  After submitting you’re 
Security Code A and Uninstall 
Code D to the website you 
should receive an email to 
your registered email account 
confirming that your Security 
Code A has been reset if you 
have received this email right 
click on the ‘Yes’ button.  

 
If you have not received this 
email after a couple of minutes 
right click on the ‘No: Go to 
Quintic website button’ and 
follow the instructions. 
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